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Introduction 1 

Polycom WebOffice is a web-based, real-time conference and 
collaboration software tool that enables the users to start and attend 
meetings, share files, instant message other users, or create audio and 
video conferences. 

Since Polycom WebOffice application is web-based, the clients of your 
Polycom WebOffice server can be connected to the system, through the 
company LAN or the Internet, and use any of the features of the system, 
from any place around the world. Polycom WebOffice is available to 
clients at any time of the day, as long as the server is properly connected 
to the network and operational, providing instant opportunities to 
collaborate with colleagues. 

To ensure the security of the system, Polycom WebOffice has Security 
options, which include document encryption and password protected 
meetings, and can be configured by the meeting owner. For added 
security, Polycom WebOffice administrator can deny web office creation 
via the Internet and require all registrations to be key-protected. 

 

Any client of Polycom WebOffice server can, at any time, initiate a 
meeting and choose which guests to invite to participate. As the Owner of 
the meeting, the client can perform the following: 

•  Choose who may or may not attend the meeting 
•  Password-protect meetings 
•  Expel meeting participants 
•  Share documents between participants, and set encryption options 
•  Monitor participants activity during the meeting, i.e. whether the 

client is attentive or whether the client is working in another program 
window 

•  Use the Voting feature to gauge the opinion of participants on any 
question presented to the group 

•  Initiate an audio or video conference 
  

A Polycom WebOffice user may access the Polycom WebOffice server by 
either starting the Polycom WebOffice client application or by typing the 
address to the server into a web browser address line. Once in the Lobby 
of the server, the user can perform any of the following: 

•  Search for a particular Polycom WebOffice 
•  Initiate an Instant Message 
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•  Leave a message for the WebOffice owner 
•  Leave a business card 
•  Take the owners business card 
•  Join a meeting started by the WebOffice owner 
•  Drop off files for the WebOffice owner 
 

This manual will present all of the features available to the WebOffice 
user and step-by-step instructions to perform the common tasks. 

Polycom WebOffice 
Polycom WebOffice is your personal area on the Polycom WebOffice 
server. From this point you may initiate meetings, chat with colleagues, 
share documents, etc. Guests may also visit your WebOffice, simply by 
typing your office address into a web browser, to send an instant message, 
leave a business card, leave a message, share documents, or request a 
meeting. 

Your WebOffice lets your customers, colleagues and business partners see 
your availability. 

Polycom WebOffice Manager 
The Polycom WebOffice Manager is a client application running on your 
computer that enables you to manage your WebOffice by configuring 
preferences, your profile data, and your online status. 

The Polycom WebOffice Manager enables you to use all of the Polycom 
WebOffice features. The Polycom WebOffice Manager is available to 
those users who have a WebOffice on the server. 

Polycom WebOffice Meeting Manager  
Polycom WebOffice Meeting Manager is a separate application that is 
integrated into your Polycom WebOffice Manager. The Meeting Manager 
specifically manages the functionality that enables you to connect to and 
participate in meetings, share documents, collaborate and share desktops. 

While connected to a meeting, the Meeting Manager provides meeting 
control features and participant status reports. 
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Using Polycom WebOffice 
A WebOffice owner can log into his/her WebOffice through an icon 
located on the desktop. Once logged in, the Polycom WebOffice Manager 
opens and the owner can perform any of the functions available. 

Starting a meeting, inviting participants, checking other WebOffice 
owner’s status, or sending an Instant Message is easily performed through 
a click of the mouse on the appropriate button. The entire functionality of 
the WebOffice is literally at your fingertips. 
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Getting Started 2 

To begin using your WebOffice, you must have a WebOffice set up for 
you by your system administrator. After connecting to your Polycom 
WebOffice, both through the client application or by using a web browser, 
log in and configure the Polycom WebOffice to your preferences. 

The following sections will guide you in the tasks of getting started as 
well as accessing and using your WebOffice: 

•  Accessing your WebOffice 
•  Downloading the WebOffice Client application  
•  Configuring your WebOffice 

Accessing your WebOffice 

Using a Web Browser 
 

The first time you visit your WebOffice from your computer, or any time 
you use a different computer, you must log in through the WebOffice 
URL using a web browser. 

 

The URL of your WebOffice follows the syntax:  

www.<WebOffice domain>.com/<your e-mail address>, e.g. 
www.polycomweboffice.com/john.smith@polycom.com.  

Check with the WebOffice administrator for the correct URL. 

 

Note: 
•  Be sure the computer you are using has access to the LAN or 

Internet in order to log in to the WebOffice server, 
•  If attempting to access the WebOffice server over the Internet, 

be sure that the WebOffice administrator has enabled access 
from outside of the server LAN. 

 

1. Enter your WebOffice URL in the address field of the web browser. 
You will see your name and availability displayed. 



Getting Started 

Polycom WebOffice User’s Manual    5

 

2. Click the OWNER LOG IN option 
 

 

 
 

3. Type in your password and click the Log In button. 
 

 
 

A connection window will open and the Polycom WebOffice Manager 
will download and start automatically.  The Polycom WebOffice Manager 
icon will appear in your system tray.  You are ready to begin work. 
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Testing System Compatibility 

Browser Test 
Polycom WebOffice requires a certain level of security settings in the 
browser to operate effectively. Rather than ask the user to manually 
configure the browser settings, Polycom WebOffice provides a utility that 
automatic tests the browser is use and instructs the user what to do if a 
problem has been found.  

This test will check the browser cookies, Java and scripting settings. In 
typical configurations, these browse settings are already enabled 
correctly. 

This test will run a thorough check for all the settings needed for 
WebOffice to operate smoothly. You can initiate a full browser test using 
the following instructions: 

1. Click the Check Mark icon in the Polycom WebOffice menu bar. 
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The test will start. The Test Page window opens at the end of the test. 

 
 

The summary of all tests results indicate the compatibility of your 
browser and its settings. If one of the settings is not configured correctly, 
its check box remains cleared and an explanation of the problem is 
displayed at the bottom of the window.  

The following screen is an example of an incorrectly configured browser 
setting. 
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4. Follow the directions presented in the window to fix the browser 
compatibility issues. 

2. Click Restart Test to re-test the browser.  

Manually Downloading the Polycom WebOffice Client 
If the client could not be downloaded and installed, it may be because of 
your browser’s security settings. The Download Client Software window 
opens displaying options to download the Polycom WebOffice client 
application. You can manually download the client application or receive 
it by e-mail. 

Downloading the Installation File 
1. In the Download Client Software window, click the Download 

WebOffice Client Software hyperlink. 
 

 
 
2. Click the appropriate here hyperlink to select the file type and to start 

the download process. 
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Once Installation File is downloaded 
If a program file is downloaded (e.g. SAClientFull.exe): 

1. Locate the downloaded file and double-click its icon to start the 
installation. 

5. Follow the instructions in the Installation section of this manual. 
 

If a ZIP file is downloaded (e.g. SAClientFull.zip): 

1. Locate the downloaded file and double-click its icon to uncompress 
the zip file.  
During the decompression process, a program file will be extracted 
and saved to the same directory as the zip file. 

6. Double-click its icon to start the installation. 
7. Follow the instructions in the Installation section of this manual. 

 

Receiving the Installation File via E-mail 
1. In the Download Client Software window, click the Get the 

WebOffice Client Software by E-mail hyperlink. 

 
 
2. In the Software drop-down list, select the file type. 
3. In the e-mail field, Enter your e-mail address  
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Once the Installation File is Received by E-mail 
If a program file is downloaded (e.g. SAClientFull.exe): 

1. Locate the downloaded file and double-click on the icon to start the 
installation 

8. Follow the instructions in the Installation section of this manual 
 

If a ZIP file is downloaded (e.g. SAClientFull.zip): 

1. Locate the downloaded file and double-click on the icon to 
uncompress the zip file.  
During the decompression process, a program file will be extracted 
and saved to the same directory as the zip file. 

2. Double-click on the icon to start the installation. 
3. Follow the instructions in the Installation section of this manual. 

 

Using Polycom WebOffice Client 

1. Click the Polycom WebOffice client icon  on your desktop to 
start the WebOffice Manager.  
Alternatively, click Start→ Polycom WebOffice→ WebOffice 
Manager. 
The WebOffice Manager window opens. 

2. Enter your WebOffice name and password in the appropriate fields. 
 

 
 

3. Select the Save Password check box to bypass the login process 
during subsequent logins to the WebOffice Manager. 

4. Click Login to continue, or Cancel to cancel the login process. 
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Notes: 
•  Internet Explorer must be enabled for ActiveX & JavaScript 

downloads.  
To configure the browser, access Tools→ Internet→ 
Security→ Internet tab.  It is recommended that you select 
Medium security, or you may set the settings manually.  

•  Enable Active X and Java Applets. To configure this feature: 
•  Open Internet Explorer and click on Tools, and select 

Internet Options→ Next.  
•  Click the tab labeled Security and then click Custom 

Level.  
•  Click Enable for all of the ActiveX controls (a total of 5). 

Scroll through the list and click the Enable option to 
enable the Scripting of Java applets.  

•  As an alternative, you may also list this site as a “trusted site” 
in the security tab. 

•  If you are connected through a firewall (most corporate LAN’s 
use one), the firewall MUST be configured to allow HTTP 
(port 80) and ActiveX downloads. 

•  Contact your IT Manager if the software fails to download. 
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Creating a New WebOffice 
Now that you have logged into the WebOffice server using your personal 
URL and password, you are ready to build your personal WebOffice. 
During WebOffice configuration, you are required to enter your details 
and to accept the WebOffice Client software agreement.  

You may manage your preferences and personal profile from the 
WebOffice once created. Refer to Chapter 3 for more information on 
using and maintaining your WebOffice.  

 

Create a new WebOffice using the following steps: 

1. If you have not already done so, open your web browser and enter the 
home address of the WebOffice URL. 
 

  
 
2. Click the BUILD AN OFFICE option 
 

 
 
 The Build an Office window opens.  
3. Complete the information requested on the registration form. 
4. Carefully read the conditions of use and select the I agree with the 

conditions below check box. 
5. Click the Submit button. 
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When the WebOffice is created, the Lobby window opens. In addition, a 
confirmation e-mail message with your WebOffice name (address) and 
password is sent to you. 

You can now log into your newly created personal WebOffice. 
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Notes: 
•  If the name that you select for your office is already in use, 

WebOffice will suggest alternatives. 
•  After creating your WebOffice, the WebOffice Manager will 

automatically install on your computer. At the beginning of 
this process, you may be prompted to grant the browser a right 
to install the software. Please make sure you choose accept, 
otherwise the setup will fail.  

•  If you are using a short URL addressing format, your 
WebOffice name will be in form of http://johnd.company.com. 
If you are using a long URL addressing format, your 
WebOffice name will be in the syntax of 
http://www.company.com/youremailaddress@yourcompany. 
com 

 



WebOffice User’s Manual15

The WebOffice 3 

Your WebOffice is your personal location on the WebOffice server where 
colleagues and business contacts can visit and instantly see your 
availability, leave a message or business card, or upload a file. From the 
WebOffice, you can initiate meetings, Instant Messages, or share 
documents with guests.  

 

When you login to your WebOffice and make your status available, you 
will be notified when a guest arrives at your WebOffice. You can send 
your guest an Instant Message, invite them to a meeting, or ignore the 
visitor. 

 

Finding a WebOffice 
 

The WebOffice client contains a feature to search for other WebOffices on 
your network without knowing the user’s URL. The Find an Office 
feature is accessible from the WebOffice Manager menu bar.  

To search for a WebOffice: 

1. Enter the partial WebOffice address or owner’s name in the blank 
field next to Find an Office. 

2. Click GO to start the search. 
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All WebOffices that match the search criteria will be returned in the 
Find an Office Results window. The window will show the 
WebOffice name, the owner’s name and company, and the 
WebOffice’s availability. 
 

 
 

3. Click on the desired WebOffice link to visit the office. 
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Visiting a WebOffice  
When you arrive as a guest to the desired WebOffice, the screen you see 
is dependent on whether the WebOffice owner is logged in and whether 
he/she is available.   

The WebOffice home screen has three sections: 

•  Owner’s Business Card 
•  WebOffice Greeting and Owner Status 
•  Available Actions 
 

In the event that the owner has not logged in, the following window is 
displayed. 

 
 

In the event that the owner is logged in, the following options become 
available in the Office Greeting pane and in the Actions pane: 

 
 

The following sections present and describe the options available in the 
WebOffice window. 
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Joining a Meeting 
 

To join an ongoing WebOffice meeting: 

 

1. In the WebOffice Actions or Office Greeting panes, click the Join a 
Meeting option. 

 

 
 

The Office Greeting pane displays an identification field. 
2. In the Office Greeting pane, in the Your Name field, enter your name 

and click the Join Meeting button.. 
 

 
 

Note: 
If the meeting is password-protected, the meeting owner must convey the 
password to you.  
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Leaving a Message for the WebOffice Owner 
 

A Guest may leave a message to the WebOffice owner. The message is 
written in an e-mail format, delivered separately to the Owner.  

1. Select the Leave a Message option. 

 
 

The Leave a Message window opens. 
2. Enter your name, e-mail address and message to the WebOffice 

meeting owner in the appropriate fields.  
A red star indicates mandatory fields. 
 

 
 

3. Click the Leave Message button to send the message. 
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Sending an Instant Message Request to the Office Owner 
 

The WebOffice lobby indicates the owner’s availability to guests. If the 
owner is available, guests can request a Chat (Instant Message) session 
with him/her.  

To initiate a chat request from the WebOffice lobby: 
1. Select the Chat With Owner option in the Actions pane of the lobby. 

 
 

The Instant Message window opens and you are be prompted to enter 
specific information before the chat request is sent to the Owner. 
Only the Name field is mandatory. 

  
 
2. Enter your name, company name and your message in the appropriate 

fields. 
3. Click the Request Chat button. 
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Retrieving the WebOffice Owner’s Business Card 
 

Guests who visit a WebOffice can retrieve the Owner business card. The 
information included in the business card is sent to the WebOffice guest 
as an e-mail message. 

 

To request the Owner’s business card: 

1. Click on the Take Owner’s Card option in the Actions pane. 

 
 

The Take Owner’s Card window opens. 
2. Enter your e-mail address. 
3. Click the Get Card button. 
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Leaving a Business Card for the WebOffice Owner 
 

Guests can leave their business card for the Owner. The guests are 
requested to enter their business information, which is sent to the Owner 
via e-mail. 

 

1. In the Actions pane, click the Leave Your Card option. 

 
 

The Leave your Card window opens. 
2. Enter your business information.  

Only the First Name, Last Name, and Email fields are mandatory.  

 
 
3. Click the Leave Card button.  

The guest’s business information is sent to the WebOffice Owner by 
e-mail. 
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Sending a File to the WebOffice Owner 
Guests can send a file to the WebOffice Owner. The files are sent as an  e-
mail attachment. 

To send a file to a WebOffice owner: 
1. Click the Drop Off Files option in the Actions pane. 
 

 
 

The Drop Off Files window opens.  
2. Enter your e-mail address in the appropriate field. 
3. Enter the path and name of the file to transfer, or click the Browse 

button to select the file from a list. 
 

 
4. Click the Confirm button to add the file to the list of files to transfer. 
5. Repeat steps 2 to 4 to add additional files to the list of files to be 

transferred to the owner. 
6. Click the Drop Off button to send the files to the Owner. 
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Using Polycom WebOffice Manager 4 

Polycom WebOffice Manager is used to manage and monitor your 
WebOffice activity. The Manager is installed and it runs automatically the 
first time you log into your WebOffice. Your WebOffice is accessed by 
clicking the WebOffice Manager icon on the desktop.  

The Polycom WebOffice Manager window includes the following panes: 

•  Toolbar pane - the top pane that contains preference and profile data 
options 

•  Status Pane - the left pane that contains information on current 
visitors and WebOffice status. 

•  Buddy list pane - the right pane that provides the list of the owner’s 
friends. It includes their individual addresses and statuses. 

 
Toolbar pane 

Buddy List pane Status pane 
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The toolbar pane provides the WebOffice owner with the following 
information and options: 

•  Displays the WebOffice Name 
•  Preferences editing 
•  Editing of the owner’s personal profile and Business Card 
•  Access to Help topics 
•  Show/Hide the Buddy List pane  

 

 
 

The Status pane displays your status (Available/Unavailable/Both), and 
the list of currently logged guests. It also provides options to start a new 
meeting (WebOffice, Video or audio), to access the WebCommander 
application or send a message to any visitor in your WebOffice. You can 
modify your status by selecting the appropriate check box. 
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The following options are available in the Status pane:  

•  Available – Notifies guests that you are available for chat.  

•  Not Available – Notifies guests that you do not want to be disturbed 
while working at the office.  

•  On Start up set to Available – When checked, your status will 
default to Available when WebOffice is started up. 

•  Start meeting – Initiate a meeting session by clicking on the button. 

Current visitors that are visiting your office will be seen in real-time 
in this window. If the guest is also a WebOffice owner, their name 
will appear in the window.  All other visitors appear as guest. 

•  Phone Link – Create a phone link for an audio conference. 

•  Video Link – Create a video link for a video conference. 

•  Web Commander – Open the WebCommander application. 

•  Send Message  – Send an instant messaging/request for chat with 
your visitors or available buddy. 

 

Note: 
The buttons Phone link, Video link, and WebCommander will only be 
visible on the left pane if WebCommander has been installed on the same 
computer as WebOffice. 
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Managing your WebOffice Preferences 
 

The Preferences menu allows the WebOffice owner to configure your 
office settings: 

•  Change the method of notification when a new guest arrives at your 
office. 

•  Choose whether you want your office listed in the Meeting directory. 
•  Change your office password. 
•  Change the Instant Message Greeting for guests. 

 

To modify your preferences use the following instructions: 

1. In the toolbar pane, click the Preferences option.  
 

 
 

 The Preferences window opens. 
 

 
 

2. Define the following options, and then click OK. 
•  Audio file – Browse for an audio file that WebOffice will play when 

a guest arrives at your office. 
•  Audio notification – Enables audio notification when guests arrive. 
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•  Pop-up notification – Enables a window that opens when a guest 
arrives in your office.  

•  Directory listing – Enable/disable your office listing in the directory. 
•  Change Password – Change your current WebOffice password. 
•  Instant Message – Provide an Instant Message greeting to a guest 

when they visit your WebOffice.  

Managing your WebOffice Profile 
You can modify Your Profile information. This information is available 
to visitors to your WebOffice and to your colleagues. Opening the Profile 
Data window enables you to modify the following information: 

•  Your personal information that can be viewed by the WebOffice 
guests. 

•  Your contact information, including address, e-mail, phone number, 
and fax number. 

 

To modify your profile use the following instructions: 

1. Click the Profile Data option in WebOffice Manager: 
 

 
 
2. Modify your personal information and click OK. 
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Buddy List 
The right pane of the WebOffice Manager window lists the friends you 
have added to your Buddy List. For each buddy listed, the individual 
status and address is displayed. You can select how to show the buddies, 
to send a message to a buddy, or to manage your list by adding or deleting 
a buddy. 

You can choose to show only those buddies that are available or 
unavailable, or both, by selecting the appropriate check box at the top of 
the pane. 
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Adding a Buddy 
To add a buddy to the list, you can either enter another user’s WebOffice 
address, or search for it in the Add Buddies window that opens after the 
option is selected. 

1. Click Add Buddy 
 

 
 
The Add Buddy window opens. 

 
 
You can add the WebOffice address of the buddy, or search for your 
friend in the Search the Directory field.  
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2. Enter the WebOffice of the buddy to add. 
3. If you do not know the address of a buddy you wish to add, use the 

search feature: 
•  Enter the partial WebOffice address or name of a buddy you wish 

to add. 
•  Click Search. 
•  Select the buddies from the search results  

4. Click the Add Buddies button. 
 

 

Deleting a Buddy 
You can delete a buddy from your list. 

1. In the Buddy list, select the name of the buddy to delete. 
2. Click the Delete button. 
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Sending an Instant Message to a Buddy 
You can send an instant message to a buddy whose status is Available.  

1. In the Buddy list, select the name of the buddy to whom to send an 
instant message 

2. Click the New Message button. 
 

 
 

The Instant Message window opens.  
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This window remains open throughout the entire Instant messaging 
session, displaying the messages sent during the session. 

3. To invite the selected buddy to your WebOffice meeting, select the 
Invite guest to a meeting to share documents check box.  

4. In the Message field, enter the message you want to send. 
5. Click the Send button. 
6. The message is sent to the Buddy. If you have selected to invite the 

guest to your meeting, link to your WebOffice meeting is added to the 
message. When the guest clicks this link she/he is automatically 
connected to the meeting.  

 

Sending Instant Message to a Visitor 
To initiate an Instant Messaging session with a guest: 
1. In the WebOffice Manager's Status pane, Current Visitors window, 

select the guest's name. 
2. Click the Send Message button. 
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Starting a WebOffice Meeting  
Any WebOffice client can start a meeting. Once the meeting is started, the 
client is considered the Owner of the meeting and has complete control 
over the activity in the meeting, unless he/she hands over the control to a 
participant. 

To start a WebOffice Meeting: 
1. In the Status pane, click the Start Meeting button. 
 

 
 
The WebOffice Meeting Manager window opens.  
 

 
 
This window is described in Chapter 4. 
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Create Audio Conference through Polycom  WebOffice Manager  
 

You can create an Audio Conference directly from the WebOffice 
Manager window. When initiated, the system automatically schedules the 
conference and notifies guests of their invitation to the conference and 
provides the phone number to call to connect to the audio conference. 

 

To initiate an Audio Conference: 
1. In the WebOffice Manager window, click the Phone Link button.  
 

 
 
The Audio Conference window opens on the meeting owner screen. 
 

  
 
The Phone Conference window opens on all meeting participants 
screens. 
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The Audio/Phone Conference window displays the phone number 
assigned to the conference call. The meeting owner and the meeting 
participants have to dial this number to connect to the conference. 
The audio conference phone number is displayed on the WebOffice 
Manager and WebOffice Meeting Manager title bar.  

 

 
 

Viewing the Conference Phone Number 
2. Start an audio meeting. 
3. On the Tools menu, click A/V Link, and then click Conference 

Properties. 
The Conference Properties window opens, displaying the conference 
type and phone number. 
 

 
 



Using the WebOffice Manager 

Polycom WebOffice User’s Manual    37

Ending the conference call 
4. In the WebOffice Manager window, click End Call. 

The Phone Conference window opens. 
5. Click Yes to confirm the termination of the call.  

 

 
 

6. Click Yes to terminate the call.  
A notification window opens on all the conference guests’ screens, 
informing them that the audio conference is about to end. 

 

 
 

7. Click OK. 
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Create Video Conference through the WebOffice Manager 
 

You can create a Video Conference directly from the WebOffice Manager 
window. When initiated, the system automatically schedules the 
conference and notifies guests of their invitation to the conference and 
provides the phone number(s) to call to connect to the video conference. 

To initiate a Video Conference: 

1. In the WebOffice Manager window, click on the Video Link button.  
 

 
 
The Video Conference window opens on the meeting Owner screen 
and also on the guests’ screens. 
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The Video Conference window displays the Video ISDN number(s) 
and H323 number (conference alias name or IP address) assigned to 
the video conference. The meeting owner and the meeting 
participants have to dial these numbers to connect to the conference. 
The video conference ISDN numbers and H.323 alias are displayed 
on the WebOffice Manager and WebOffice Meeting Manager title 
bar. 
 

 
 

Note: 
To dial a H323 number, you should type in the MCU Prefix and then the 
H323 number. The MCU Prefix is unique to each MCU and is assigned in 
the MGC Manager application. For more information, refer to the MGC 
Manager Administrator’s Guide.  For help, contact your system 
Administrator or Polycom Support. 

 

Viewing the Conference Number 
1. Start a video meeting. 
2. On the Tools menu, click A/V Link, and then click Conference 

Properties. 
The Conference Properties window opens, displaying the conference 
type and phone numbers. 
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Ending the conference call 
1. In the WebOffice Manager window, click End Call. 

The Video Conference window opens. 
2. Click Yes to confirm the termination of the call.  
3. Click Yes to terminate the call.  

A notification window opens on all the conference guests’ screens, 
informing them that the audio conference is about to end. 

 

 
 

4. Click OK. 
 

 

 



Using the WebOffice Manager 

Polycom WebOffice User’s Manual    41

Accessing the WebCommander from WebOffice Manager 
You can access the WebCommander application from the WebOffice 
Manager window. The WebCommander application enables you to 
monitor your audio and video conferences using any Web browser. 

In the WebOffice Manager window, click the WebCommander button. 

 
The default Web browser window opens, displaying the WebCommander 
login window. The WebCommander address (e.g. http://WebCommander 
IP/ConfSiteV4_5) is displayed in the Web browser’s Address box. 
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Holding a WebOffice Meeting 5 

Meeting Overview 
A WebOffice meeting is a web-based session in which multiple guests can 
collaborate on ideas while sharing documents, applications, and 
screenshots. Meeting participants use the Polycom WebOffice Meeting 
Manager software to join the meeting, load documents and applications, 
and to make on-screen annotations.  The Owner of the meeting uses the 
Polycom WebOffice Meeting Manager to direct the flow and focus of the 
meeting. The WebOffice Meeting Manager features include: 

•  Invite guests 
•  Secure the meeting and its content 
•  Select documents to display  
•  Share applications  
•  Save the meeting contents 

Before a Meeting 
Prior to starting a Meeting you can: 

•  Secure the Meeting by specifying a password that all guests must 
enter to join 

•  Limit the number of guests in the Meeting 
•  Upload documents to the WebOffice that will be used during the 

Meeting 

During a Meeting 
When you start a meeting, the WebOffice Meeting Manager displays a 
blank Whiteboard screen on which you can draw freehand diagrams and 
post text messages using the Annotation Tools. 

Both you and your guests can open documents, or capture and share 
screen snapshots. Several documents can be opened simultaneously in a 
Meeting. However, at all times, the WebOffice owner controls which 
document or snapshot is displayed to everyone. 
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Meeting participants can use the Annotation Tools to draw or write on the 
document, with various shapes or arrows to clarify a point, just as they 
would on the Whiteboard. Each participant's notations are displayed in a 
unique color. 

You may also choose to share an application in real-time with the meeting 
participants. Application Sharing enables your guests to view any 
application running on your computer. As you make changes and navigate 
throughout the application, your guests can see your computer screen - 
but only for the application you select.  

You maintain complete control of which window is displayed to guests. 

After a Meeting 
When a Meeting ends, you can save it in the WebOffice for later use. 
Saved Meetings contain the presented documents, along with participants' 
markings and annotations. 
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The Meeting Manager  
The WebOffice Meeting Manager window opens on the desktop when a 
meeting is initiated by a WebOffice owner. The Meeting Manager 
provides functionality for document and application sharing, a whiteboard 
for freehand drawing and comments, and participant status. 

 

 
 

Hiding the Instructions Box 
A message box providing instructions on how to invite guests opens when 
you login to your WebOffice, by default.  

 

To hide this message window: 

1. On the Tools menu, click Options. 
The Options dialog box opens. 

2. Clear the Enable instruction assistance... check box, and then click 
OK.  
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Working with Guests 

Running Secure Meetings 
You can prevent uninvited guests from joining a meeting in progress by 
defining a guest password. If a password has been defined, a Password 
field appears in the Guest Login box. Guests will be admitted to the 
meeting only after typing the correct password.  You can also limit the 
number of guests, or lock the meeting. Guests can receive a meeting 
password via email, chat or on by phone. 

 

Running Secure Meetings - Defining a Guest Password 
You can prevent uninvited guests from joining an ongoing meeting by 
defining a guest password. Once a password has been defined, a 
Password field appears in the Guest Login box. Guests will be admitted to 
the meeting only after typing the correct password. 

 
 

 
 

3. On the Security menu, click Meeting Password. Alternatively, on 
the toolbar, click the Security icon and then click Meeting Password 
on the pop-up menu. 
The Meeting Password dialog box opens. 

 
 

4. Select the Enable Meeting Password check box. 
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5. In the Enter Meeting Password field, type a password of 4 characters 
or more. 

6. Click OK. 
 

Limiting the Number of Guests in a Meeting 
The Max Participants option enables you to set the maximum number of 
meeting participants. If the limit is reached, your status will change to 
Unavailable. 

1. On the Security menu, click Number of Participants. Alternatively, 
on the toolbar, click the Security icon, and then click Number of 
Participants on the pop-up menu. 
The Max Participants window opens. 

2. Set the Maximum number of guest participants field to between 1 and 
120.  

 
 

3. Click OK. 
 

Note:  
The number of supported participants depends on meeting usage and 
server capacity. 
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Locking a Meeting 
You can lock an ongoing Meeting, in order to prevent new guests from 
joining. 

On the Security menu, click Lock. Alternatively, on the toolbar, click the 
Security icon, and then click Lock on the pop-up menu. 
 

 
 

The meeting remains locked until the meeting ends or is unlocked. A 
check mark next to the Lock option indicates that the meeting is locked. 

 

The Participants Pane 
The Participants pane enables every participant in the meeting to monitor 
the status of other participants in the meeting. The Participants pane 
displays the following information: 

 
 

Field Description 

Name Identifies each participant by name and color assigned to 
their Annotation tools. The Owner's tools are always red. 

View Shows whether a participant can see the updated pages 
and annotations display. A red signal means the display is 
being updated. The green signal indicates that participants' 
display is updated with the recent changes. 

Focused Shows whether a participant is currently focused on the 
Meeting Manager window. A red signal means that the 
meeting window is not the active window on their computer. 
When focused, the signal turns green. 

Document in view Shows the currently selected document. When another 
document is selected and displayed, the new document 
name appears in each participant's line. 

Number of pages Shows how many pages of the selected document have 
already been retrieved from the Office. If a page is selected 
outside of the normal sequence, it is retrieved immediately 
and its number displayed before the other pages numbers. 
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Dynamic Participant “Viewing/Focus” indicator 
The WebOffice client automatically changes into an accumulative 
feedback mechanism for large meeting sessions. It is based on a 
predefined participant threshold, as shown in the figure below. 

 

 

 

The individual participant status indicators disappear and are replaced 
with one indicator indicative of the whole group. 
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Working with Documents 
 

The WebOffice Meeting Manager allows you and your guests to 
collaborate across the Web and share documents and applications. The 
application includes easy-to-use tools that are accessible both from the 
menus and from toolbar. The Meeting Manager displays the active 
document in the large left windowpane. In the right windowpane, the 
Meeting Manager displays the following information about the current 
meeting: 

Document in View 
Shows the name of the document currently displayed and allows you and 
the meeting owner, to navigate through the pages within the document. 

Change Document 
Lists all documents open in the current meeting and allows the meeting 
owner to select which one to display.  

Participants 
Displays a list of all the meeting participants and enables everyone to 
monitor the status of other participants: 

•  Viewing – This feature helps you pace your presentation by 
indicating whether or not everyone is seeing the same display. A red 
viewing button next to a participant's name indicates that their 
display is not yet synchronized to the latest changes. When the 
Viewing button turns green, it means that both participants are seeing 
the same thing. 

•  Focus – This feature informs you if the Meeting window is active on 
a specific guest‘s computer. When the guest has the meeting in focus 
the button is green. When the guest does not have the meeting in 
focus the button turns red. 

You can toggle between hiding and viewing the right pane by selecting 
Right Pane in the View menu. 
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Document Encryption 
Use encryption to secure the documents that you display in a Meeting. 
You can use the same encryption key for all or some of your documents, 
or use a different key for each. The Meeting guests must enter the 
encryption key before they can view the document. 

Encryption Procedure 
During the Upload or Open procedures, the encryption dialog box 
appears. The dialog options are: 

Don't encrypt this document - If selected, you can choose not to encrypt 
any document. In this case the encryption dialog box will not appear 
again. You can later change this setting from the Security menu. 

Encrypt - Type an encryption key, and send it to your guests. 
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Opening Documents in a Meeting 
Documents can be opened as follows: 

From the WebOffice Meeting Manager 
Select Open from the File menu or the toolbar, and navigate to the 
desired document.  
This is the only method available to the participants. You can open a 
document that is stored either in your local computer or in your 
WebOffice. 

From Windows Explorer 
Use the drag-and-drop or copy/paste actions to add the document to the 
Active Meeting folder under the WebOffice directory. 

From an Application 
1. Open the desired file 
2. Save it to the Active Meeting folder under WebOffice. 

To display the document in the WebOffice Meeting Manager, select 
it in the Change Document section. 

Notes 
The first page can be viewed before the whole document is retrieved. 
Only the WebOffice owner can select the documents and pages to be 
displayed. 

 

The Status Bar 
The Status Bar tracks the process of opening a document. The Status Bar 
represents every document or snapshot that is opened in a Meeting by two 
blue flashing circles and a progress bar.  

When several Open processes take place at the same time, click the 
corresponding circle to display the progress bar of the document it 
represents. By default, the progress bar represents the most recent action. 

To cancel Opening a document,  

Click the red “X” icon next to the progress bar and select the desired 
process from a list. 
 

Note:  
When you cancel a process, all pages that are already loaded will be 
available in the Meeting Manager.  

 



Holding a WebOffice Meeting 
 

 WebOffice User’s Manual 52

Uploading Documents to the WebOffice 
You can upload documents at any time - before, after, or during a 
meeting. It is recommended to upload your documents before the meeting 
starts in order for them to be available right away at meeting time. 

You can upload a document in any of the following methods: 

From the WebOffice Meeting Manager 
1. Select Upload from the Tools menu. 
2. In Windows Explorer, right-click the file and select Upload. 

or 

Use the drag-and-drop, or copy/paste actions to add the document to 
the Documents folder inside the WebOffice directory. 

•  From an Application 
•  Open the file, and save it to the Documents folder under 

WebOffice. 
or 

Open the Print dialog box, select Publisher from the printers list and 
print the document. 

Note: 
To view the document correctly in the WebOffice Meeting Manager, set its 
page size to A4 before printing. 

 
Note: 
The Uploading procedure only copies documents to your WebOffice. To 
display the document in the WebOffice Meeting Manager, you must open 
it. 
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Viewing, Annotating and Navigating Documents 

Managing Documents and Meetings 
When you open a WebOffice, a WebOffice icon is added to your Desktop. 
Selecting the WebOffice icon from the Desktop, or Windows Explorer, 
displays the contents of your WebOffice as folders. These folders are: 

Active Meeting - Contains the documents and snapshots open in the 
current meeting. 

Saved Meetings - Contains a list of your saved meetings. 

Documents - Contains a list of the documents saved in the WebOffice. 

 

 
  

 

Selecting Documents for Display 
The documents and snapshots currently open in a meeting appear in the 
Change Document section. To display an item, select it from the list. 

 

Note:  
Only the WebOffice owner can select documents.  
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Taking a Snapshot 
You can capture your current screen, or part of it, and open it in the active 
session. 

Note:  
The first time you use the Snapshot command, the required software is 
downloaded and installed on your computer. This may take one or two 
minutes. 

 

1. From the Snapshot toolbar or the File→ Open menu select: 
Active Window Snapshot, to capture the whole screen, 
or Selected Area Snapshot, to capture a rectangular area. 

2. A dialog box guides you through the Snapshot process. 
Click Hide to minimize the dialog box. 

 

 
 

When the screen capture ends, the Preview window opens. If you are 
not content with the result, click Recapture to take another snapshot. 

4. Click Publish to send the Snapshot to the meeting. A Loading 
progress bar appears during the process. 

5. Select the snapshot from the Change Document section. The snapshot 
appears as Snapshot (n) where "n" represents the sequence number. 
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Using Annotation Tools 
The Annotation tools, under the Edit menu or flyout, are used to mark and 
annotate the displayed page. Only one tool can be selected at a time. After 
selection it remains in an active state until another tool is chosen. Each 
participant in a session has his/her own tool color, indicated in the 
Participants section.  

Following is a description of the available tools: 

 

Tools Icon Description 

Single pointer   Place a pointer on the displayed page. Every 
mouse click moves the single pointer at the cursor 
location. 

Multiple pointer   Place several pointers on the displayed page. 
Every mouse click adds a new pointer. 

Rectangle tool   Draw a rectangular frame on the displayed page. 
To draw a frame, click and drag the left mouse 
button from one rectangle corner to the opposite 
one. 

Ellipse tool   Draw an elliptical frame on the displayed page. To 
draw an ellipse, click and drag the left mouse 
button. 

Line tool   Draw a straight line on the displayed page. To 
draw a line, click and drag the left mouse button 
from the line's beginning point to its end. 

Text tool   Annotate the displayed page. Click where you 
want to add an annotation and type the text. 

To start a new line click Enter. 

To finish writing, click anywhere on the screen. 

Free Hand tool  Draw a curve line on the displayed page. To draw 
a curve, click and drag the left mouse button from 
the curve’s starting point to its end. 

Marker tool  Highlight text or any other part of the displayed 
page, including shapes. To use the marker, click 
and drag the left mouse button from the line's 
beginning point to its end. 

Undo last   Undo the recent action. Repeat to delete previous 
annotations in reverse order. 

Clear All   Clear all annotations from all documents. When 
used by the owner, all the participants' 
annotations are deleted. 
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Using the Zoom Control 
With the Zoom control, you can adjust the display size to fit your local 
display setting, or focus on special points of interest. The Zoom function 
is not synchronized between participants, allowing each participant to 
select his/her own scaling. 

 
 

1. Click the Zoom button, or select Zoom from the View menu. 
2. Select the desired scaling from the list. 

 

Working with Multi-page Documents 
To display a specific page of the current document, select it in the Select 
Page list under Document in the View menu.  Use the Backward/Forward 
buttons to browse through the displayed document. 

 

 
 

Note: 
Only the Office owner can select pages. If the right pane is hidden, the 
Backward and Forward buttons will appear on a small toolbar. Annotation 
tools remain in the document and are saved when jumping from page to 
page. 
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Deleting a Document from the Meeting 
Delete Document from meeting enables the owner of the meeting to 
delete or remove a particular document from an existing meeting. To 
delete a document from the meeting, the owner selects the appropriate 
document and clicks the Delete button, as indicated in the figure below. It 
is also possible to delete the document by right clicking on the 
document’s name and selecting Remove Document from the menu. 
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Application Sharing 
 

Using the Application Sharing feature, you can share (with guests) any 
application that is running on your computer. Guests will only see the 
application you select.  

Sharing an Application 
Open the Application. An application must be running before you can 
share it in the meeting. 

1. Select Share Application from the File menu or click the Share 
button from the main toolbar. 

2. Select the desired application in the Share Application window. 
3. To display only the active window, select Share Selected Window 

only.  
4. Deselecting this option will show your guests all windows running 

the selected application. 
5. Click the Share button to display the selected application on the 

screens of all guests in the meeting. The Share Application window is 
automatically minimized to your task bar.  

 
 

6. Bring the Share Application window into focus to change or end 
application sharing:  

7. Highlight another application and click Share to begin sharing 
another application. 

8. Click Entire Desktop to share your entire desktop. 
9. End Sharing will stop sharing the current application but will leave 

the Application Sharing window running on guests' computers. 
10. Click Refresh to update the list of available applications if you wish 

to share an application that was not running when you launched 
application sharing. 
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11. Click End Sharing to terminate application sharing. 
12. Click the Synch/Control tab to delegate the control to one of your 

guests:  
Only one participant can be in control at a time. 

To hand over the control over the documents 
1. Click your mouse to gain back control 
2. Use the Synch color indication to know your guest status – 

•  Green – Guest’s Application Sharing viewer is synchronized 
•  Yellow – Guest Application Sharing viewer is about to be 

synchronized – no updates are being sent – only communication 
delay 

•  Red - Guest Application Sharing viewer is not synchronized 

 
 

Note: 
You can share only one application at a time. Selecting another application 
replaces the application on the screens of your guests. 
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Desktop Sharing 
 

Desktop Sharing allows the owner of the WebOffice to take over the 
guest’s PC. If a desktop sharing is taking place, both the owner of the 
WebOffice and a guest can share a running application.  

Sharing a Desktop  
1. Select Remote Control from the File menu or select the Remote Ctrl 

icon from the main toolbar. 
A Remote Control window is opened with the list of guests, 
participants in your Meeting.  

 
2. Select one of the guests in the list, to share a desktop. 

At the guest’s computer, after the guest’s confirmation, a Share 
Application window is opened, in which the guest can select whether 
to share the entire desktop or just a running application.  
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Role Delegation In Application Sharing 
 

The owner of the WebOffice has, by default, the control over the Meeting 
and over the Desktop Sharing. However, the control can be given to one 
of the guests, by using the right tab in the Remote Control window. The 
owner can grant the control over the session to each of the guests.   

The guest, in the right tab of the Share Application window 
(Synch/Control) selects the participant to grant the control to. 

This window can be minimized and restored for convenience. 
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Voting  
Voting provides an automated mechanism for the meeting owner to query 
the meeting participants and receive immediate feedback from them on 
the results of the query.   

Activating the Voting Feature 
1. On the Meeting Manager toolbar, click the “Voting” icon or on the 

Tools menu, click Voting.  
 
 

  
The WebOffice Voting window opens. 
 

 
 

2. In the Question box, enter the vote subject/question. 
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3. In the Time of Voting box, define the duration of the Voting session. 
Clearing the Time of Voting check box results in unlimited voting 
duration. 

4. To add the Vote options, click the Add button. 
The Voting Answer dialog box opens. 
 

 
 

5. In the text box, enter the text for the first choice and click OK. 
The new Voting choice is added to the Answers list. 

6. Repeat steps 5 and 6 to define additional Voting choices. 

Note: 
To remove one of the Voting choices, click the choice to remove in the Answers box, 
and click the Remove button. 

7. When you have finished defining the voting subject/question and its 
choices, click the Start Vote button.  

8. The Voting session status is displayed in the WebOffice Meeting 
Manager window and can be monitored at any time. 
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9. The new Vote is submitted to all participants. Each meeting 
participant selects an answer from the WebOffice Voting dialog box 
and clicks the Vote button. 
 

 
 
The vote is sent back to the owner and is tallied with polling 
information. 

10. The Owner is then provided with a real time update of voting results, 
as shown in the figure below. 
 

 
 

Note: 
- The subject of angoing vote cannot be edited. 
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To stop the Voting session: 
You can stop an ongoing voting session using one of the following 
options: 

•  In the Voting pane of the Meeting Manager window, click the Stop button. 

•  In the Meeting Manager toolbar, click the Stop Voting icon. 

 
 

•  On the Tools menu, click Stop Voting. 
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Removing a Participant from the Meeting 
Remove Participant allows the owner to remove individual participants 
from a meeting while the meeting is in progress. To remove a participant 
from the meeting, the owner selects the appropriate participant and clicks 
on the Remove button as indicated in the figure below.  The owner may 
also remove a participant by right clicking on the participant’s name and 
selecting Remove Participant from the menu. 
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Saving a Meeting 
Use the Save Meeting option to keep a record of your meetings. Saved 
meetings include all the documents that were viewed, along with 
participants' markings and comments. If you need to interrupt a meeting, 
you can save it, and resume later from wherever you left off. 

 

1. Click the Save button, or select Save Meeting from the File menu. 
2. Type a name and a description for the meeting and click Save. The 

meeting is saved to your WebOffice. 
Saved meetings are kept in the Saved Meetings folder 

 

Opening a Saved Meeting 
Select File > Open, or click the Open button. 

The Open dialog box appears. Navigate to the Saved Meetings folder 
under WebOffice, and select the desired meeting. 

You can also open the meeting directly from Windows Explorer. By 
default, the WebOffice Meeting Manager stores saved meetings in the 
server under My Offices. 
 

Note  
Opening a saved meeting replaces the current meeting in the WebOffice 
Meeting Manager. 
When an interrupted meeting is resumed, guests' tool colors may differ 
from those in the saved meeting. 
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Utilities and Technical 

Requirements 6 
 

To enable immediate communication between subscribers, as well as 
between subscribers to their non-subscriber guests, WebOffice features an 
open web IM, which is coupled with a mechanism that detects the 
presence of a guest on the system. 

To achieve this functionality efficiently, Polycom requires subscribers 
and non-subscribers to be maintain their web browsers with the default 
browser security settings (medium security - in the case of Internet 
Explorer).  In addition, users must have certain rights over their own 
desktop, enabling them to install software and printer drivers. In the event 
that the user cannot change his security settings, it may be possible to still 
use the downloadable client.  

WebOffice communicates over HTTP using the standard port. WebOffice 
communication is compatible with firewall, NAT and proxy systems. In 
most cases, if a user is able to browse an external Web site they will be 
able to utilize WebOffice. In the event that company network security 
policies restrict certain browser features such as Signed-ActiveX (IE), 
Signed-Plug-in (Netscape), JavaScript, High-Safety Java and cookies, 
WebOffice will be able to operate without the full functionality related to 
web registration, automatic software installation, guest presence detection 
and Instant Messaging. 

Below is a list of WebOffice web browser-activated features, and their 
required security settings (special settings only):  

WebOffice Feature  Required Security Setting 

General Web Operation File Download, Java-Script, Per-Session Cookies 

Automatic client software 
download 

Signed-ActiveX (IE) Download & Run, Signed 
Plug-in (NS) Download & Run 

Automatic client software 
upgrade 

Signed-ActiveX (IE) Run, Signed Plug-in (NS) 
Run 

Subscriber Web Login Stored Cookies for name recognition, Signed-
ActiveX (IE) Run, Signed Plug-in (NS) Run 

Guest Join a Meeting Stored Cookies for name recognition,  

Guest Presence Detection Java-Script, Per-Session Cookies, Java applets 

Subscriber buddy presence 
detection/awareness 

Requires no special security setting as it runs 
from the WebOffice Office Monitor (MOM) 
application 

Instant Messaging Java Applets, Stored Cookies 
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Internet Explorer Medium Security Default Settings 
Below are figures depicting the Internet Explorer Security Settings 
options. The Security Setting window has many options that can be 
scrolled through. For this manual, they are presented one at a time to 
illustrate the exact configuration that will aid WebOffice in operating 
efficiently. 
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Netscape Default Security Settings 
The following screen displays the default Netscape security settings: 

 

Using the Log Generator 
The Log Generator records your recent activities in a file. The system log 
files are made available for use by the Technical Support team in the 
event of a system error.  

 
To retrieve the system log file: 
1. Download the Log Generator from 

http://www.company.com/solutions/utilities.html 
2. Download the Log Generator from 

http://www.company.com/solutions/utilities.html 
3. Double click the file WebOfficelog.exe to start the Log Generator. The 

Problem Context Packager window will appear 
4. Type the problem description and select a destination folder for the log 

file, named WebOffice.pcp 
5. Click OK. The Log Generator will automatically update the log every 

time you run the WebOffice Manager 
6. After running the WebOffice Manager, email the log file 

(WebOffice.pcp) to the Technical Support team address 
 

Note: 
The Log Generator records data only from your most recent session. 



Utilities and Technical Requirements 

 WebOffice User’s Manual 74

 


	Table of Contents
	Introduction
	Polycom WebOffice
	Polycom WebOffice Manager
	Polycom WebOffice Meeting Manager

	Getting Started
	Accessing your WebOffice
	Using a Web Browser
	Testing System Compatibility
	Browser Test
	Manually Downloading the Polycom WebOffice Client
	Downloading the Installation File
	Receiving the Installation File via E-mail

	Using Polycom WebOffice Client
	Creating a New WebOffice

	The WebOffice
	Finding a WebOffice
	Visiting a WebOffice
	Joining a Meeting
	Leaving a Message for the WebOffice Owner
	Sending an Instant Message Request to the Office Owner
	Retrieving the WebOffice Owner’s Business Card
	Leaving a Business Card for the WebOffice Owner
	Sending a File to the WebOffice Owner

	Using Polycom WebOffice Manager
	Managing your WebOffice Preferences
	Managing your WebOffice Profile
	Buddy List
	Adding a Buddy
	Deleting a Buddy
	Sending an Instant Message to a Buddy

	Sending Instant Message to a Visitor
	Starting a WebOffice Meeting
	Create Audio Conference through Polycom WebOffice Manager
	Viewing the Conference Phone Number
	Ending the conference call

	Create Video Conference through the WebOffice Manager
	Viewing the Conference Number
	Ending the conference call

	Accessing the WebCommander from WebOffice Manager

	Holding a WebOffice Meeting
	Meeting Overview
	Before a Meeting
	During a Meeting
	After a Meeting

	The Meeting Manager
	Hiding the Instructions Box

	Working with Guests
	Running Secure Meetings
	Running Secure Meetings - Defining a Guest Password
	Limiting the Number of Guests in a Meeting

	Locking a Meeting
	The Participants Pane
	Dynamic Participant “Viewing/Focus” indicator

	Working with Documents
	Document in View
	Change Document
	Participants
	Document Encryption
	Opening Documents in a Meeting
	From the WebOffice Meeting Manager
	From Windows Explorer
	From an Application

	Uploading Documents to the WebOffice
	Viewing, Annotating and Navigating Documents
	Selecting Documents for Display
	Taking a Snapshot
	Using Annotation Tools
	Using the Zoom Control
	Working with Multi-page Documents
	Deleting a Document from the Meeting

	Application Sharing
	Sharing an Application
	Desktop Sharing
	Sharing a Desktop
	Role Delegation In Application Sharing

	Voting
	Removing a Participant from the Meeting
	Saving a Meeting
	Opening a Saved Meeting

	Utilities and Technical Requirements
	Internet Explorer Medium Security Default Settings
	Netscape Default Security Settings
	Using the Log Generator


